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Notices

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://green.asus.com/english/REACH.htm

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:
+  This device may not cause harmful interference; and

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

k The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.
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RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning
CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the

same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.



Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

+ DO NOT cover the vents on the Desktop PC to prevent the system from getting
overheated.

+ DO NOT use damaged power cords, accessories, or other peripherals.

+  To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

»  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

»  Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+ Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.

vii
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Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

when trying to complete a task.

CAUTION: Information to prevent damage to the components

{ DANGER/WARNING: Information to prevent injury to yourself
! when trying to complete a task.

IMPORTANT: Instructions that you MUST follow to complete a
task.

NOTE: Tips and additional information to help you complete a
task.

N 9

Where to find more information

Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.


http://www.asus.com
http://support.asus.com/contact

Package contents

ASUS Essentio Desktop PC Keyboard x1 Mouse x1
Power cord x1 Nero 9 burning software Installation Guide x1

DVD x1

Warranty card x1 Antenna (optional) x2

/ + If any of the above items is damaged or missing, contact your retailer.

— + Theillustrated items above are for reference only. Actual product specifications may vary
with different models.



Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CM5671 Desktop PC!

The ASUS Essentio CM5671 Desktop PC provides cutting-edge performance,
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a
stunningly futuristic and stylish system casing.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

% llustrations are for reference only. The ports and their locations, and the chassis color vary
- with different models.

Front panel

ASUS €SSENTIO SERIES

% Click the number to view its
corresponding description.

ASUS CM5671 11
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USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

Microphone port (pink). This port connects to a microphone.

Headphone port (lime). This port connects to a headphone or speaker.

Power button. Press this button to turn on your computer.

Optical disk drive eject button. Press this button to eject the optical disk drive tray.

Optical disk drive bay (empty). Allows you to install an additional optical disk drive in
this bay.

Optical disk drive bay. There is an optical disk drive in this bay.

Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory
Stick Pro™ card into this slot.

Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ / MultiMediaCard
card into this slot.

CompactFlash®/ Microdrive™ card slot. Insert a CompactFlash® / Microdrive™ card
into this slot.

Rear panel

% Click the number to view its
corresponding description.

Chapter 1: Getting started



1. Power connector. Plug the power cord to this connector.
2. Power switch. Switch to turn ON/OFF the power supply to your computer.

3. Air vents. These vents allow air ventilation.

DO NOT block the air vents on the chassis. Always provide proper ventilation for your
computer.

4.  PS/2 Keyboard / Mouse Combo port (purple). This port is for a PS/2 keyboard or
mouse.

5.  USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

6.  Optical S/PDIF_OUT port. This port connects to an external audio output device via
an optical S/PDIF cable.

7.  HDMI port. This port is for a High-Definition Multimedia Interface (HDMI) connector,
and is HDCP compliant allowing playback of HD DVD, Blu-ray, and other protected
content.

8.  DVI-D port. This port is for any DVI-D compatible device and is HDCP compliant
allowing playback of HD DVD, Blu-ray, and other protected content.

9.  VGA port. This port is for VGA-compatible devices such as a VGA monitor.

10. USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

11.  LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)
through a network hub.

LAN port LED indications ACT/LINK SPEED
LED LED
Activity/Link LED Speed LED
= -
OFF No link OFF 10Mbps connection -
ORANGE | Linked | ORANGE | 100Mbps connection
BLINKING \ Data activity \ GREEN \ 1Gbps connection LAN port

ASUS CM5671
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16.

17.
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18.

19.

20.

Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

Microphone port (pink). This port connects to a microphone.

Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.

Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

Refer to the audio configuration table below for the function of the audio portsin a 2, 4, 6,
or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

Port 2'_":::::; 4-channel 6-channel 8-channel
Light Blue Line In Line In Line In Line In
Lime Line Out Front Speaker Out Front Speaker Out Front Speaker Out
Pink Mic In Mic In Mic In Mic In
Orange - - Center/Subwoofer Center/Subwoofer
Black - Rear Speaker Out Rear Speaker Out Rear Speaker Out
Gray - - - Side Speaker Out

ASUS WLAN Card (on selected models only). This optional WLAN card allows your
computer to connect to a wireless network.

ASUS Graphics Card (on selected models only). The display output ports on this
optional ASUS Graphics Card may vary with different models.

Expansion slot bracket. Remove the expansion slot bracket when installing an
expansion card.

Chapter 1: Getting started



Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card (on selected models only)

Connect your monitor to the display output port on the discrete ASUS Graphics Card.
To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.
2. Plug the monitor to a power source.

% The display output ports on the ASUS Graphics Card may vary with different models.

ASUS CM5671



Using the onboard display output ports
Connect your monitor to the onboard display output port.
To connect an external monitor using the onboard display output ports:

1. Connect a VGA monitor to the VGA port, or a DVI-D monitor to the DVI-D port, or an
HDMI monitor to the HDMI port on the rear panel of your computer.

2. Plug the monitor to a power source.

wiREE

If your computer comes with an ASUS Graphics Card, the graphics card is set as the
primary display device in the BIOS. Hence, connect your monitor to a display output port
on the graphics card.

2

+To connect multiple external monitors to your computer, refer to Connecting multiple
external monitors in Chapter 3 of this user manual for details.

Chapter 1: Getting started



Connecting a USB keyboard and a USB mouse

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.

Connecting the power cord

Connect one end of the power cord to the power connector on the rear panel of your
computer and the other end to a power source.

ASUS CM5671



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:

1. Turn on the power switch.

2. Turn your monitor ON.

3. Press the power button on your computer.

Power button

4. Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.

2. Click E on the Windows® desktop.

3. Click [EM=ESEIEN] to shut down the operating system.

Chapter 1: Getting started



Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language. Click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout. Click Next.

4. Key in uniques names for the user name and computer name. Click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

% If you want to set up a password for your account later, refer to the section Setting up a
user account and password in this chapter.

6.  Carefully read the license terms. Tick | accept the license terms and click Next.

7. Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CM5671 2-1
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Using Windows® 7 desktop

% Click the Start icon ﬂ > Help and Support to obtain more information about Windows® 7.

Start menu

Taskbar

Notification area

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows?® taskbar, click the Start icon €
2. From the Start menu, select the item that you want to launch.

% You may pin programs that you want constantly displayed on the Start menu. For more
- details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Chapter 2: Using Windows® 7



Using the Getting Started item

The Getting Started item on the Start menu
contains information about some basic tasks such
as personalizing Windows®, adding new users, and
transferring files to help you to familiarize yourself
with using Windows® 7.

To use the Getting Started item:
1. From the Windows® taskbar, click the Start
icon E to launch the Start menu.

2. Select Getting Started. The list of available
tasks appears.

3. Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows?® taskbar, click an icon to launch it. Click the icon again to hide the
program.

e gefur | ===

/ You may pin programs that you want constantly displayed on the taskbar. For more details,
- refer to the section Pinning programs on the Start menu or taskbar on this chapter.

ASUS CM5671
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Pinning items on the jumplists

When you right-click an icon on the taskbar, a
jumplist launches to provide you with quick-access
to the program’s or item’s related links.You may
pin items on the jumplist such as favorite websites,
often-visited folders or drives, or recently played
media files.

To pin items to the jumplist:
1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that
you want to pin, then select Pin to this list.

Unpinning items from the jumplist
To unpin items from the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to remove from the jumplist, then

select Unpin from this list.

Frequent

[@[Pin to this lst Jacri

Tasks
@ Resume previous list

| Play all music

@ Windows Media Player
o Unpin this program from taskbar

Pinning programs on the Start menu or taskbar

To pin programs on the Start menu or taskbar:
1. From the Windows® taskbar, click the Start icon
to launch the Start menu.

2. Right-click the item that you want to pin on the
Start menu or taskbar.

3. Select Pin to Taskbar or Pin to Start menu.

You may also right-click on the

va icon of a running program on

the taskbar, then select Pin this
program to taskbar.

B laternat Exple Open

S Micressfy OffF Troutdbechoot compatibdity
% WMiersscht o

B indeaty] | PO THOBN

€ Windows Dvg]  Pintn Start Menu

558 Windows Fax | ) 5ean for Sacurity Thesstt
€ Windows Mag i
3 Windows Med Rastnne peavicut virmsad.
& Windows Upd Sandis

o XPL Viewer

I hccemores Cut
LSS Copy
| Gamas

Mainbensnce|  Deieie
I Micrssch ot & Rename

& Mizrescty

I Microsaft

E1 Micrasaft Office Omeblote 2007
T Micrsacft Offica PowarPeint 2007
[ Micresoft Dffice Word 2007

ki Whicreasft Office Tech
Micresaft Office Live Add-m

(@) AlManager1.07.00
= Pin this program to taskbar

[E Close window
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Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar:
1. From the taskbar, right-click the program . i, Microsoft Office Ward 2007
that you want to remove from the taskbar, 4| o Unpin this program from taskbar
then select Unpin this program from
taskbar.

Using the notification area
By default, the notification area shows these three icons:

Action Center notification

E Click this icon to display all the alert messages/notifications and
launch the Windows® Action Center.

Network connection

. This icon displays the connection status and signal strength of the
wired or wireless network connection.

Volume

Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

- Click the Notification icon [F, then click || % 1 messoqe
the message to open it. :

'S'l' Set up backup

Open Action Center

5:45 PM
9/7/2009

% For more details, refer to the section Using Windows® Action Center in this chapter.

ASUS CM5671
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Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the
notification area.

To customize icons and notifications:

1. From the notification area, click on the arrow icon E
Click Customize.
3. From the dropdown list, select the behaviors for the icons or items that you want

customize.
[ = &3 Contm Funsi harm, » Histha stcn Seva from = | 5p [l v Corrst e =
L
Sebect which icons and notificastions appear on the taskbar
B o chsces b ik e -
e oy ey
[ Bebrenes
o Wt Ll e .
b e Sram wom ot mothcstont -
b b s »
Ackon e S o s sty -
of Nk T - -
Oy thom e st -
by i o8 i a2 rotbucstion o the ik
. T
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Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon E to launch the Start menu.
2. Click Computer to launch Windows Explorer.

View icon

Breadcrumb bar

—— Search bar
Toolbar —¢- c- —— Preview icon
& Dences with Removable Storage (2
DYDY Dove T) —
3 -
Navigation — —— View pane
pane

Exploring files and folders

To explore files and folders:

1. Launch Windows Explorer.

2. From the navigation or view pane, browse for the location of your data.

3. From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

+ Computer # WINT [T} ¥ Lisens | =1+ Searnh Lt £

tee
Ogunize v Iocludeinibany v Sh | L fier v @
Fubls

" dil ke
8 Dowelasds Nattnew
B Recent Paces Public

# Documents

ASUS CM5671
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Customizing the file/folder view
To customize the file/folder view:

1. Launch Windows Explorer.

2. From the navigation pane, select the location of your

data.

From the toolbar, click the View icon &= ~.

From the View menu, move the slider to select how you

want to view the file/folder.

- on the View pane, click View, and

You may also right-click anywhere
select the view type that you want.

Arranging your files
To arrange your files:

1. Launch Windows Explorer.

k| Extra LargeIcons

| Largelcons

s Medium Icons

=4 Small Icons

S List
= Details
5IC Tiles

°= Content

Arrange by 3

View »
Sort by »
Refresh

Paste

Paste shortcut

Share with »

New »

Extra large icons
Large icons
Medium icons
Small icons

List

Details

Tiles

Content

Properties

2. From the Arrange by field, click to display the dropdown list.

3. Select your preferred arrangement type.

Chapter 2: Using Windows® 7




Sorting your files

To sort your files: Arrange by v
. View >
1. Launch Windows Explorer. T ST
Right-click anywhere on the View pane. Group by I
Refresh Type
From the menu that appears, select Sort E— Size
by, then select your preferred sorting type. Paste shortcut ©  Ascending
Undo Copy Ctrl-Z Descending
Share with 3 More...
New 3
Properties
Grouping your files — -
To group your files: View R
1. Launch Windows Explorer. R e
Right-click anywhere on the View pane. e ?“E medified
Paste spe
From the menu that appears, select S Size
Group by, then select your preferred UndoRename  CtrlsZ W
grouping type. — .| Ascending
© Descending
New 3
More...
Properties T
Adding a new folder
To add a new folder:
1. Launch Windows Explorer. . i
Organize ~ Share with Burn New folder
2. From the toolbar, click New folder.
3. Key in a name for the new folder.
v
% You may also right-click anywhere '
/. on the View pane, click New > '
Folder.
Undo Rename (=14
Share with .
Hew L Felder
Propuriies (] Shorzut
- | & Bamap enage
[ Contsct
] Microsoft Office Word Document
& Joumsl Docurment
Tt Documant
oy Windows Live Call
|5 Microsoft Office Excel Worksheet
| Compressed (ipped) Folder
B Bricfcase
—
ASUS CM5671



Backing up your files

Setting up a backup
To set up a backup:

1. Click E > All Programs > Maintenance > Backup and Restore.
2. Click Set up backup. Click Next.

H = System and Secunty » Backup and Riestore BN B e

o

Centrol Panel Home y -
Back up of restore your files

% Create n ystem repai dise Windows Backup has nat been set up. B det up backup

Windows could not find & backup for this computer,

3. Select your backup destination. Click Next.

4.  Select Let Windows choose (recommended) or Let me choose as your backup
mode.

% If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data.

To restore your system:

1. Close all running applications.

2. Click E > All Programs > Accessories > System Tools > System Restore.

3. Follow the onscreen instructions to complete the process.

2-10 Chapter 2: Using Windows® 7



Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

/ You may customize the notifications. For more details, refer to the previous section
Customizing icons and notifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click
the Notification icon m then click Open

Action Center. | ) Set up backup

Open Action Center

5:45 PM
9/7/2009

« Sg N o) P

2. From Windows 7 Action Center, click the task that you want to do.

-

¥ o Centrod Panel + System and Security + Action Center =ilise:
o o ——

Comrs! Fanel ba .
o et e Review recent messages and resolve problems

Change Action Center seftings ‘hction Center hurs desected oo or mare issues for you bo e,

W Change Uses ccount Control

Tetings Sequrity s
‘View mchived messages
View pesformasce ifaemation Maintenance o
St up back:
p brthig o et yp backeg

Vensr Files.

W s it s b problem uted, iy ane of theve

b& Riitiont yout computes b n patker
tima
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Using Windows® Update

Windows Update allows you to check and install the latest updates to enhance the security

and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1.
2.

From the Windows® taskbar, click the Start icon E to launch the Start menu.

Select All Programs > Windows Update.

From the Windows Update screen, click the task that you want to do.

“} » Control Panel » System and Security » Windows Update + |5 [ Search Control Panei

2]

Control Panel Home

Check for updates
Change settings

View update history
Restore hidden updates

Updates: frequently asked
questions

®

Windows Update

N Turn on automatic updating
N Updates are not being installed automatically
Tum on automatic updating to help improve the security and
performance of your computer and allow standard users to install

updates on this computer,
"%/ Turn on automatic updates

Let me choose my sttings

Most recent check for updates:  Never
Updates were installed: Never
You receive updates: For Windows only.

Get updates for other Microsoft products. Find out more
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Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

From the Windows® taskbar, click E > Getting Started > Add new users.

1.
2. Select Manage another account.
3.  Select Create a new account.
4. Key in the name of the new user.
5. Select either Standard user or Administrator as the user type.
6.  When done, click Create Account.
B, « User Accounts » Mansge Accounts » Creste New Account - |4 P
MName the account and choose an account type
Thes narme will sppear on the Welcomme screen and on the Start menu,
Matthew|
& Mandard uoe
Standard sccount users can use most suftware and change system settings thet do not effect clher users or
the security of the computer,
Aderunistrator
Adrmirnstraturs have complete access o the computer and can mke any desiced changes, Based on
may passward ar Betore
making changes that affect other uers:
We recurmemvend thet you protect every sccount with & strong password,
Why s standsd sccount tecomumended
[ Cresteccount | [Concel |
ASUS CM5671
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Setting up a user’s password

To set up a user’s password:

1. Select the user that you would like to set a password.
2. Select Create a password.

)
L ]

c, + Wher Aecounty » Mamage Accesnty § Change sa Accourd w4y

Make changes to Matthew's account

B Lonhew

Key in a password and confirm it. Key in your password’s hint.
When done, click Create password.

Create a password for Matthew's account

h ] Matthew

B S| Standurd wser
You aee creating a passmord for Marthew.

1 you i this anps
Web sites o network resources.

To v lising dati i the Future. ask Matthore 1 mske 8 pasimord reset Nloppy dk

The passeord him wil be visibke tc everyone wh uses this computer

(g ] | e
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Activating the anti-virus software

Trend Micro Internet Security is pre-installed on your computer. It is a third-party anti-virus
software protecting your computer from virus attacking. It is purchased separately. You have
a 60-day trial period after activating it.

To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Input your e-mail address and select your location. Click Next.
4

Click Finish to complete the activation.

Getting Windows® Help and Support

Windows® Help and Support provides you with guides and answers in using the applications
in Windows® 7 platform.

To launch Windows® Help and Support, click E > Help and Support.

__E’""'?"'

P = W i s optiom -

o

() Find an answer guickly
Enter & few words i the search box above
ich ha ion, downdoads, and ideas for getting the mast out
&4, More support opticns
M Offiipe Help =
% Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 2.0/1.1 ports on both the front and rear panels. The USB
ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

+  Insert the USB storage device to your computer.

Front panel Rear panel

To remove a USB storage device:

1. Click & from the Windows notification area on your
computer, then click Eject USB2.0 FlashDisk.

@ Open Devices and Printers

q Eject USB2.0 FlashDisk
- Removable Disk (F:)

2. When the Safe to Remove Hardware message | @ safe 7o Remove Hardware ax
pops up, remove the USB Storage device from The 'USB Mass Storage Device' device can now be safely
’ removed from the computer.
your computer.
/ gi DO NOT remove a USB storage device when data transfer is in progress. Doing so may
L cause data loss or damage the USB storage device.
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio I/O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

AUDIO
INPUTS
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Connecting 4-channel Speakers

AUDIO AUDIO

INPUTS INPUTS

- /

Connecting 6-channel Speakers

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS

ASUS CM5671
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Connecting 8-channel Speakers
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Connecting multiple external displays

Your desktop PC may come with VGA, HDMI, or DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:
1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

% For some graphic cards, only the monitor that is set to be the primary display has display
- during POST. The dual display function works only under Windows.

ASUS CM5671
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Turn on your computer.

Do any of the following to open the Screen Resolution setting screen:

+  Click > Control Panel > Appearance and Personalization > Display >
Change display settings.

. Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.

5. Select the display mode from the Multiple displays: drop-down list.

+  Duplicate these displays: Select this option to use the additional monitor as a
duplicate of your main display.

+  Extend these displays: Select this option to use the additional monitor as an
extension display. This increases your desktop space.

+  Show desktop only on 1/2: Select this option to show desktop only on monitor
1 or monitor 2.

+  Remove this display: Select this options to remove the selected display.

' -~ Dapley ¢ Screen Resshson

Change the appearance of your displays

Digplay: . ASUS PMITTS

Erchsten 1260 « M {recommanded) -

Lrrtation: Landsape -
Duphcate these dcpleyy j

Thiz s cumently yo
enl
andl cthes Show deskaep eoly on 2
Remeree this deipley

1 e

6.  Click Apply or OK. Then click Keep Changes on the confirmation message.

s ~
Display Settings I@

Do you want to keep these display settings?

[ Keep changes ]E Revert |

| Reverting to previous display settings in & seconds.
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

% + You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.

ASUS CM5671
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain to
your wrists, hands, and other joints or muscles. This section provides you with tips on avoiding
physical discomfort and possible injury while using and fully enjoying your Desktop PC.

Eye level to the top of
the monitor screen
<

Foot rest 90" angles

To maintain the proper posture:

Position your computer chair to make sure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

. Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

. Sit upright with your knees, elbows and hips at an approximately 90° angle when you
are at the PC.

Place the monitor directly in front of you, and turn the top of the monitor screen even
with your eye level so that your eyes look slightly downward.

Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

. Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and straight sunlight.

. Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

To use the memory card:

1. Insert the memory card into the card slot.
% + Amemory card is keyed so that it fits in only one direction. DO NOT force a card into a
slot to avoid damaging the card.

You can place media in one or more of the card slots and use each media independently.
Place only one memory card in a slot at one time.

2. Select a program from the AutoPlay window to access your files.

% + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
onit.

Each card slot has its own drive icon which is displayed on the Computer screen.

The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

3. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

) E To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
) notification area before removing the memory card.
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Using the optical drive

Inserting an optical disc
To insert an optical disc:

1. While your system is on, press the eject button below the drive bay cover to open the
tray.

Place the disc to the optical drive with the label side facing up.
Push the tray to close it.
4. Select a program from the AutoPlay window to access your files.

% If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,
click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1. While the system is on, do either of the following to eject the tray:
+  Press the eject button below the drive bay cover.
+ Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

2. Remove the disc from the disc tray.

ASUS CM5671
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Using the multimedia keyboard
(on selected models only)

/ The keyboard varies with models. The illustrations on this section are for reference only.

ASUS SK-2045 keyboard

Keys Description Keys Description

Launches Windows® gadgets. Press <Fn + F7> to launch Microsoft®
12. E MSN or, if not installed, connects to the
MSN download page.

Press <Fn + F8> to launch Windows®
Search screen.

—_

N

Activates Windows® Flip 3D. 13 .

Reduces picture size in Windows®

Photo Viewer. 14.

Increases picture size in Windows® 15 u
Photo Viewer. ’

Functions with keys F1~F12. 16 n

Press <Fn + F9> to play or pause
playback in Windows® Media Player.

w

Press <Fn + F10> to stop playback in
Windows® Media Player.

>

Press <Fn + F11> to go to the previous
track in Windows® Media Player.

o

Press <Fn + F12> to go to the next

Press <Fn + F1> to launch Microsoft® u
track in Windows® Media Player.

Word.

Press <Fn + F2> to launch Microsoft® @
Excel.

Press <Fn + F3> to launch Microsoft® @
PowerPoint.

Press <Fn + F4> to launch Microsoft® @
Internet Explorer. ’

Press <Fn + F5> to launch Microsoft® @
Outlook. ’

Press <Fn + F6> to launch the Launches Windows® Media Center.
Favorites folder in Windows® Internet | 22. O
Explorer.

Decreases the system volume.

~

Increases the system volume.

o

Turns the volume’s mute mode on/off.

©

Launches Windows® Media Player.

—
o

HEEOEBEGARO® O

-
jur

The special function keys only work on Windows® Vista / Windows® 7 operating systems.

N
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ASUS-Razer Arctosa Gaming keyboard

Plays or pauses playback in a media
player.

Stops playback in a media player.

Goes to the previous track in a media
player.

Goes to the next track in a media
player.

&

Decreases the system volume.

o

Increases the system volume.

(=2}
=
) 4

Turns the volume’s mute mode on/off.

~

o

Switches profiles working with F1 ~
| F10 keys.

+ The special function keys work on Windows® XP / Vista / 7 operating systems.

N

Install the keyboard driver before using. Visit the Razer website at
www.razersupport.com to download the driver.
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www.razersupport.com

BTC 6200C keyboard

Keys

. ®

. ®

@

@O0 0

ES

—
o

~N

Des

Enters into sleep mode. Press any key
to wake up your computer and return to
the previous working status.

Returns to the last page you viewed.

Goes to the next page you viewed
before.

Launches the default homepage in
Windows® Internet Explorer.
Launches the Favorites folder in
Windows® Internet Explorer.

Launches your default email application.

Decreases the system volume.

Increases the system volume.

Turns the volume’s mute mode on/off.

Goes to the previous track in a media
player.

Plays or pauses playback in a media
player.

Goes to the next track in a media player.

Stops playback in a media player.

N

46

The special function keys work on Windows® ME / 2000 / XP / Vista / 7 operating
systems without installing a driver. For Windows® 98SE operating system, visit the BTC
website at www.btc.com.tw to download the driver.

Install Microsoft® Internet Explorer 5.0 or later versions before using the Internet keys.
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Connecting to the Internet

Wired connection

Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Set up your DSL/cable modem.

% Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

Turn on the DSL/cable modem and your computer.

Configure the necessary Internet connection settings.

Contact your Internet Service Provider (ISP) for details or assistance in setting up your
Internet connection.

‘&P'@
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

2. Turn on your computer.
3. Configure the necessary Internet connection settings.

% Contact your network administrator for details or assistance in setting up your Internet
connection.
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Wireless connection (on selected models only)

Connect your computer to the Internet through a wireless connection.

R To establish a wireless connection, you need to connect to a wireless access point (AP).

% + Toincrease the range and sensitivity of the wireless radio signal, connect the external
- antennas to the antenna connectors on the ASUS WLAN Card.

+ Place the antennas on the top of your computer for the best wireless performance.

+ The external antennas are optional items.

ASUS CM5671
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To connect to a wireless network:

1. Click the network icon . in the notification area to display the available wireless
networks.

Mot comnected “

dﬂ Connections sre svailsble

Wirthess Network Connection -
WL-530gV2 =

ol
A5 Office al
$60-10 at
040Q -"1.‘
50130 A

Open Hetwark and tharing Center

2. Select the wireless network that you want to connect to, then click Connect.

| et connected 4

dﬂﬂ Connections ae available

Wirsleee Metwork Connecticn -
WL-S30gV2 .

4 Comc i
Agus-WIA o
As Dffice M
oA sl
=01 wll
Al a
550-130 |

Open Metwork and Sharing Center

3. You may need to key in the network security key for a secured wireless network, then
click OK.
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4. Wait while your computer is connecting to the wireless network.

Connecting to WL-530gV2 ...

5. The wireless connection is established successfully. The connection status is displayed
and the network icon displays the connected status.

Ciarraritly connected te:

Wirelezs Metwark Comnectien -
WLSI0gV2 Connected
s WL A 8
A3 Ol =
default .d'
550-130 il
DAGQ il
010 o
Alva a"l' -

Open Network and Sharing Center
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Using the Utilities

% The support DVD and Recovery DVD are not included in the package. You can burn it by
yourself. Refer to section Recovering your system for details.

ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

Installing Al Manager
To install Al Manager:

1. Place the support DVD in the optical drive. If Autorun is enabled, the Drivers installation
wizard appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Al Manager folder in
the support DVD.

2. Click the Utilities tab, then click ASUS Al Manager.

3. Follow the onscreen instructions to complete the installation.

Launching Al Manager
To launch the Al Manager from the Windows® desktop, click Start > All Programs > ASUS >
Al Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

Right-click this icon to switch between the quick bar and the
main window, and to launch the Al Manager either from the
quick bar or taskbar.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or
Information tab to display the menu’s contents.

| F.P ‘ .:.—-
|

Main Support

Exit button
Switch to main Window
Add to ToolBar

My Favorites Information

Click the Maximize/restore button I to switch between full window and quick bar. Click the
Minimize button = to keep the Al Manager on the taskbar. Click the Close button = 1o quit
the Al Manager.

Main

The Main menu contains five utilities: Al Disk, Al Security, Al Boosting, and Al Probe. Click
the arrow on the Main menu icon to browse through the utilities in the main menu.

Il =, e | BRI
! ' _ﬁ‘_‘. .‘al ::;_I |J}
2 Dl =ik DAL i ok to optay

items on the right

@ Al Manegen

Click to extend or restore

Click to display-
items on the left

Al Disk

Al Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.

PER Y

ANE S

Select the items thal you waril fo clear

p——— [~ Clear Temporary IE Files [ CtesrIE URLis) History
ﬁ Indoamation

[T Ciear ik Cockies [T Clear IE Histary

[ Clear Rocycl Bin [ Cloas Recently Opened Files

ADEAy
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Al Security
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1. When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

2. Confirm the password.
Key in the password hint (recommended).
When done, click Ok.

‘ NS =R By

o

* e v pas sworc{Lsss langh i 20 chirs)

P

* Rikinpot niw passwod
** represant you mestai o

Inges new paseword himt

Select the device you want to lock, then click Apply.
Key in the password you have set previously, then click Ok.

IARS =l EEY

Lack o
accessle

¥ use flasn Diska)

[ covovo Disks)

To unlock the device:

1. Deselect the locked device, then click Apply.

2. Key in the password you have set previously, then click Ok.
To change the password:

+  Click Change Password, then follow the onscreen instructions to change
password.
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Al Booting
Al Booting allows you to specify the boot device priority sequence.

3 Siaeislinis|
Balncl e devics, e click tha 18/ right buion o sty he boot
segquence.

2

To specify the boot sequence:

1. Select a device, then click the left/right button to specify the boot sequence.
2. When done, press Apply.

Al Probe
Al Probe automatically detects and displays the motherboard and CPU temperatures,
CPU fan speed, and the voltage output. You can adjust the values as you need.

Click the Temperature, Voltage, or Fan Speed tab, then select an item to enable and
change the value by dragging the bar.

BEOE |

1 Temeersture | -+ vemmge [ 2 Fanspeea

| Evamed  Seessr Coert |

Threatan
(=] =1 " — 70 G
' C—

(]
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My Favorites

My Favorites allows you to add applications that you frequently use, saving you from
searching for the applications throughout your computer.

To add an application:
1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.

Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.

ASUS CM5671
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Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.

ASUS EPU-4 Engine

ASUS EPU-4 Engine is an energy-efficient tool that provides you with a total system
power-saving solution. It detects the current computer loading and intelligently adjusts
the power in real-time. It automatically adjusts the power usage for the CPU, VGA card,
hard drives, and CPU fan. It provides you with these modes to choose from: Auto, High
Performance, and Maximum Power Saving Mode.

/ Refer to the section ASUS EPU-4 main screen for more details about these modes.

Installing ASUS EPU-4
To install ASUS EPU-4 Engine:

1. Place the support DVD into the optical drive. The Drivers menu appears if Autorun is
enabled on your computer.

If Autorun is disabled, double-click the setup.exe file from the ASUS EPU-4 Engine folder
in the support DVD.

2. Click ASUS EPU-4 Engine.

3. Follow the onscreen instructions to complete the installation.

Launching ASUS EPU-4
To launch ASUS EPU-4:

1. From the Windows taskbar, click the 11:18 AM
-4 - '{" ] ".‘ ¥
ASUS EPU-4 icon. 10/10/2009
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2. When you launch ASUS EPU-4 for the
first time, a message appears asking
you to calibrate the EPU functions.

Click Calibrate and wait for a few
seconds for the calibration process
to complete. The ASUS EPU-4 main
menu appears.

Calibrate

% Calibration allows the system to detect the CPU properties for optimal power management.

ASUS EPU-4 main screen

CPU status
Displays the current CPU power and the total CPU power saved.
VGA card status

Displays the status of the graphics card. If your graphics card is not compatible
with the motherboard, a “No VGA card detected” message appears.

/ Refer to the ASUS VGA QVL List at http://event.asus.com/mb/EPU-4_Engine/ for
a compatible VGA cards.
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HDD status
Lights up when the power saving mode is activated.

Fan status
Display the current fan status.

CO02 Emission button
Displays the current or total reduced CO2 emission.

Mode properties
Displays the properties of each mode.

Exit button
Closes the ASUS EPU-4 utility,

Calibrate button
Allows the system to detect the CPU properties for optimal power management.

Setting button
Click this button to configure the mode settings.

© 00 0 6 060

/ Refer to the section Configuring the mode settings for more details.

@ Modes

Auto Mode

When you select this mode, the system changes modes
automatically according to the current system status.

[~ ] | High Performance Mode

—1 | When you select this mode, the system overclocks the components
for maximum performance.

@ Maximum Power Saving Mode

When you select this mode, the system automatically adjusts the
power usage for critical components in real-time to save power.
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Configuring the mode settings
To configure the mode settings:

1. From the ASUS EPU-4 main menu, click Setting to launch the Setting screen.

2. Click the ! ‘ tab to configure the settings of High Performance mode. Click
! tab to configure the settings of Maximum Power Saving mode.

3. Configure any of these mode settings:

vCore Voltage Downgrade: Lowers CPU vCore voltage.

+  Heavy: Downgrades voltage to the highest level for CPU power saving.
+  Medium: Downgrades voltage to the medium level.

+  Small: Downgrades voltage to the minimum level.

. Turn Off hard disks: Turns off hard disk drives when they are not accessed after a
certain time.

CPU Loadline: Sets up the CPU loadline to manage CPU power saving.
+  Light: Saves CPU power to the minimum level.

+  Medium: Saves CPU power to the medium level.

+  Heavy: Saves CPU power to the highest level.

Turn Off Screen: After the specified idle time, the screen turns off while all background
tasks are still running.

4. Click OK to apply the settings made.
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ASUS Update

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment.

+ ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

+ This utility is available in the support DVD.

Installing ASUS Update
To install ASUS Update:

1. Place the support DVD in the optical drive. The Drivers menu appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Update folder in the
- support DVD.

2. Click the Utilities tab, then click Install ASUS Update.

3. Follow the onscreen instructions to complete the installation.

/ Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS
To update the BIOS:

1. From the Windows® desktop, click Start > Programs > ASUS > ASUS Update >
ASUS Update to launch the ASUS Update utility.

2. From the dropdown list, select any of the updating process:

Updating from the Internet
a. Select Update BIOS from the Internet, then click Next.

b.  Select the ASUS FTP site nearest you to avoid network traffic, or click Auto
Select then click Next.

c. From the FTP site, select the BIOS version that you wish to download then click
Next.

/ The ASUS Update utility is capable of updating itself through the Internet. Always update
the utility to avail all its features.

Updating from a BIOS file
a. Select Update BIOS from a file, then click Next.

b. Locate the BIOS file from the Open window, then click Open.

3. Follow the onscreen instructions to complete the updating process.
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ASUS MyLogo2™

The ASUS MyLogo2™ utility lets you customize the boot logo. The boot logo is the image
that appears on screen during the Power-On Self-Tests (POST). ASUS MyLogo2™ is
automatically installed when you install the ASUS Update utility from the Support DVD.

R + Obtain the latest BIOS file from the ASUS website at www.asus.com.

+ You can create your own boot logo image in GIF file format.

To launch ASUS MyLogo2™:

1. Launch the ASUS Update utility. Refer to the section “ASUS Update” in this user
manual for details.

Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before flashing
BIOS, then click Next.

4.  Select Update BIOS from file from the drop down menu, then click Next.

When prompted, locate the new BIOS file, then click Next. ASUS MyLogo window
appears.

6. From the left window pane, locate the
image that you want to use as your boot
logo. Click Next.

7. From the Ratio dropdown list, select your
desired size for the boot logo. Click Next.

8.  The system starts updating the BIOS and
loading the new boot logo.

9.  After the updating process, the system
restarts and displays the new boot logo
during POST.
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Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.
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Installing Nero 9
To install Nero 9:

1. Insert the Nero 9 DVD into your optical drive.
2. If Autorun is enabled, the main menu appears automatically.

% If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero
9 DVD.

3. From the main menu, click Nero 9 Essentials.
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4. Select the language you want to use for Installation Wizard. Click Next.
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7.

Select Typical then click Next.

Hiaec, U Frasntals - lntslation

ect Installation Type

Please select an installation type:

Tick Yes, | want to help by sending anonymous application data to Nero then click
Next.
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When done, click Exit.
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Installation Successful
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Burning files
To burn files:
1,

From the main menu, click Data Burning > Add.
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Select the files that you want to burn. When done, click Add.
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3. After selecting files that you want to burn, click Burn to burn the files to a disc.

7

D rae: ayOne

For more details about using Nero 9, refer to the Nero website at www.nero.com

Recovering your system

Using the Recovery Partition

The Recovery Partition quickly restores your Desktop PC’s software to its original working
state. Before using the Recovery Partition, copy your data files (such as Outlook PST files)
to USB storage devices or to a network drive and make note of any customized configuration
settings (such as network settings).

About the Recovery Partition

The Recovery Partition is a reserved space on your hard disk drive used to restore the
operating system, drivers, and utilities installed on your Desktop PC at the factory.

AN

DO NOT delete the partition named
RECOVERY. The Recovery Partition
is created at the factory and cannot be
restored if deleted. Take your Desktop
PC to an authorized ASUS service
center if you have problems with the
recovery process.

Using the Recovery Partition:

1. Press <F9> during bootup.

2. Press <Enter> to select Windows Setup [EMS Enabled].
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3. Select one of the following recovery options.
System Recovery:
This feature allows you to restore the system to the factory default settings.

System Image Backup:

This feature allows you to burn the system image backup in DVD discs, which you can use
later to restore the system to its default settings.

System DVD Backup:
This feature allows you to make a backup copy of the support DVD.

4. Follow the onscreen instructions to complete the recovery process.

% Visit the ASUS website at www.asus.com for updated drivers and utilities.

Using the Recovery DVD (on selected models)

Prepare 1~3 blank writable DVDs as instructed to create the Recovery DVD.

Remove the external hard disk drive before performing system recovery on your Desktop
PC. According to Microsoft, you may lose important data because of setting up Windows on
the wrong disk drive or formatting the incorrect drive partition.

To use the Recovery DVD:
1. Insert the Recovery DVD into the optical drive. Your Desktop PC needs to be powered
ON.

2. Restart the Desktop PC and press <F8> on bootup and select the optical drive (may be
labeled as “CD/DVD”) and press <Enter> to boot from the Recovery DVD.

Select OK to start to restore the image.
Select OK to confirm the system recovery.

R Restoring will overwrite your hard drive. Ensure to back up all your important data before
the system recovery.

5. Follow the onscreen instructions to complete the recovery process.

g DO NOT remove the Recovery disc, unless instructed to do so, during the recovery process
or else your partitions will be unusable.

/ Visit the ASUS website at www.asus.com for updated drivers and utilities.

ASUS CM5671
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Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

. Check if your computer is properly connected.
. Check if the wall outlet is functioning.

Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

. Do the following to close the programs that are not responding:
1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manger.
2. Click Applications tab.
3. Select the program that is not responding, then click End Task.
. If the keyboard is not responding. Press and hold the Power button on the top

of your chassis until the computer shuts down. Then press the Power button to
turn it on.

? I cannot connect to a wireless network using the ASUS WLAN Card
(on selected models only)?

. Ensure that you enter the correct network security key for the wireless network
you want to connect to.

. Connect the external antennas (optional) to the antenna connectors on the
ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on your
computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

| want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.
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?  The picture on the HDTV is stretched.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:
1. Do any of the following to open the Screen Resolution setting screen:
- Click ¥ > Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

Check if your speak is connected to a electrical source and turned on.

Adjust your speakers’ volume.

Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click from the Windows notification area, then click | & .
If it is not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

ASUS CM5671

Check if the disc is placed with the label side facing up.

Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.
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?

The DVD drive eject button is not respond.

1. Click > Computer.

. . i DVD RW Drive . .
2. Right-click s:\@ , then click Eject from the menu.
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